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Getting Started

1.1

Introduction

PreSonus® Capture™ 2.0 is a multitrack digital-audio recording application designed
to make recording with StudioLive™ mixers quick and easy. With the look and feel of
a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same highquality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its Session
files can be opened directly in Studio One—no conversion or exporting required.
Capture 2.0 was designed exclusively for StudioLive-series mixers,
allowing instant setup and recording directly from the mixer, with
no configuration. Just launch Capture 2.0 and click Record Now. At
the end of the show, click Stop, save the file, and you’re done!
When used with the StudioLive 16.4.2 and 24.4.2, Capture 2.0 will record an
additional stereo track from any of the mixer’s buses that are accessible to the
Auxiliary Inputs router. More information about the Auxiliary Inputs router can
be found in Section 3.7.1 in the StudioLive Software Library Reference Manual.
In general, the features that make a DAW a powerful tool for audio production
and mixing in the studio are the very culprits that bog down a computer’s
performance and make for an unstable live-recording environment. Capture
2.0 simplifies this environment, providing only the tools necessary to record a
great performance, without placing huge demands on your CPU’s resources.
As with all of the StudioLive Software User Library, you should check the PreSonus
Web site for the latest version of Capture 2.0. You can download Capture 2.0
updates from your My PreSonus account once you have registered your StudioLive
hardware. For instructions on creating a My PreSonus account, please see
Section 7.1.2 (Step 3) in the StudioLive Software Library Reference Manual.
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•• Multitrack recording application (unlimited input
channels plus stereo stream from StudioLive)
•• NEW! One-click recording with Record Now button
•• NEW! Prerecord captures audio up to a minute before you press Record
•• NEW! Auto-Save
•• NEW! Automatic session and file recovery if the power fails
•• NEW! Sessions store metadata, enabling automatic session naming
•• NEW! Soundcheck mode makes it simple to virtually
soundcheck using previously recorded material
•• NEW! Session Lock feature prevents accidental keyboard access
•• Essential editing suite (copy, cut, paste, splice, resize)
•• NEW! Big Meter mode turns your monitor into a gigantic meter bridge
•• NEW! Stereo Playback mode—use Capture with any computer soundcard
•• Peak LED-style meter bridge with clip indicators
•• Marker placement and recall
•• NEW! Marker List with Quick Locate
•• Export between markers
•• Record stereo mix from StudioLive mixer
•• Full transport control
•• Import/export individual WAV, AIFF, or OpenTL
•• Compatible with Mac® and Windows®

1.3

System Requirements

Mac
•• Mac® OS X 10.6.8 or later
•• Intel® Core™ Duo processor (Intel Core 2 Duo or Core i3 or better recommended)
•• 2 GB RAM (4 GB or more recommended)
Windows
•• Windows® 7 x64/x32 SP1 or Windows 8 x64/x86
•• Intel Core Duo or AMD Athlon™ X2 processor (Intel Core 2
Duo or AMD Athlon X4 or better recommended)
•• 2 GB RAM (4 GB or more recommended)
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Installation Instructions

Mac and Windows Systems
•• IEEE 1394 FireWire 400 Port
•• Internet connection (needed for activation)
•• DVD-ROM drive
•• Internal or external 7200 RPM storage drive highly recommended
•• Monitor with 1024x768 resolution
Power User Tip: The speed of your processor, amount of RAM, and the size and
speed of your hard drive will greatly affect the overall performance of your recording
system. In addition, the maximum recording time supported by Capture 2.0 is
affected by the availability of RAM. It is therefore recommended that 64-bit systems
with 4 GB or more of RAM be used when recording uninterrupted for more than 10
hours. For slower systems, or for systems with the minimum requirement of RAM,
it is recommended that the recording be stopped and restarted every 6 hours.

1.4

Installation Instructions

1.4.1 Mac OS X
Installing Capture 2.0 on Mac OS X machines is as simple as drag-and-drop.
1. Double click on the Capture .dmg file.

2. Drag the Capture 2.0 icon to the Applications folder shortcut.

3. Once Capture has been copied to your hard drive, it is ready to use. Simply
open your Applications folder and double-click on the PreSonus Capture
2.0 icon.
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1.4.2 Windows
The Windows installer for Capture 2.0 was designed with easy to follow
onscreen instructions to make the installation process quick and simple.
1. When you launch the Capture.exe file, a Welcome Screen will launch. If
you haven’t already done so, close all other open applications before
clicking “Next.”

2. Before Capture 2.0 can be installed on your computer, you must first
agree to the licensing terms. Click “I agree.”

3. By default, Capture 2.0 will install in the Program Files folder on your
computer. It is highly recommended that you do not change this
default location. Click “Install.”

4. Once Capture 2.0 has been successfully installed on your computer,
you can click “Finish” to exit the install wizard. You’re ready to start
recording!
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You will be taken to the Start page when Capture 2.0 is launched. The
Start page allows you to create a new Session, open a Session stored
on your computer, view recent Sessions, and verify that your StudioLive
is properly communicating with its driver. In addition, you can begin
recording instantly by just clicking the Record Now button.

2.1

Tagging and Organizing a Session
At the top of the Start page, you will find the three Name Scheme
fields: Artist, Performance, and Location. By entering information into
each of these fields, your Session will be automatically named with this
information, in this order, and tagged with the same helpful metadata.
These tags also help to keep your files organized. Rather than throwing
every Session into a single folder, all tagged Sessions will automatically
be put into an organized folder hierarchy. By default, Capture 2.0
inserts the date of performance and creates subfolders. These options
can be changed in the Options menu, see Section 2.5.3 for details.
By default, the folder tree is Artist/Performance/Location. This structure
is useful for regularly gigging bands that want to archive performances
(e.g., Artist: PreSonus Allstars, Performance: Winter Tour 2013, Location:
Baton Rouge – Manship Theatre). However, Capture 2.0 doesn’t limit you
to this folder structure. You can change the folder hierarchy from the
Options menu. Here are other available Name Schemes:

•• Location/Artist/Performance. This Name Scheme is especially useful
for venue owners who are archiving the performances on their stage
(e.g., Location: Manship Theatre/PreSonus Allstars/Winter Tour 2013.
•• Location/Performance/Artist. Use this Name Scheme when recording
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus Allstars).
As you archive your performances, Capture 2.0 stores a history of the
names you have entered into each field. To use a name again, simply
click on the pull-down menu for that field and select it from the list.

To clear the currently selected name from the list, select
Remove First from the pull-down menu.

To remove every name in the list, select Clear History. Once the history has been
cleared, it cannot be undone, so be certain before you choose this option.
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Creating a Session
Below the Name Scheme fields, you will find the New Session button. Click on the
New Session button to create an empty Session.
Power User Tip: A Session is a Capture 2.0 file in which you record, arrange,
and edit your audio files. Session files should not be confused with audio
files. Think of a Capture 2.0 Session as you would a StudioLive Scene. It is a
snapshot of which audio files were recorded and how they were edited.
You can also create a new Session by doing one of the following:
•• Navigate to File/New Session.
•• Press [Ctrl]/[Cmd]+N on the keyboard.

If you have filled in the Name Scheme fields, your
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

•• Session Title. This will be the title of your Session and will be the Session filename,
as well as the name of the new folder that contains all data related to your Session.
•• Session Location. This is where new Sessions and all related data will be saved.
The Session location can be chosen each time you create a Session. By default,
the new Session location will be the Capture 2.0 folder in your Documents folder.
You can choose a different file location by clicking on the Browse button and
browsing to a new location. The last known save location will appear as the default
the next time you create a new Session.
Power User Tip: The Name Scheme fields have been added to Capture 2.0
to help keep your Sessions organized and to make your archived library
of live performances more easily searchable. Because of this, we highly
recommend that you always take a moment to fill in these fields.
6

2
2.3

Capture™ 2.0 Software
Reference Manual

Start Page
Open a Session

2.2.1 Record Now!
Clicking the Record Now button on the Start page will launch a new Session, arm all
tracks for recording, and begin recording immediately. If you do not have any of the
Name Scheme fields customized, your Session will be labeled with today’s date.

2.3

Open a Session
The Capture 2.0 Start page provides two different
ways to quickly open previous Sessions.

Open Session Button
Clicking on the Open Session button will open a browser that will allow you to
browse for, and open, an existing Session.

Recent Files List
Located below the Open Session button, you will find the Recent
Files list. This list includes links to the most recently opened
documents. Click on any of these links to quickly open the
Session.

Locate Missing Files
In the event that the Session you open is missing audio files, Capture
will help you find them. Use Session>Locate Missing Files to search
your computer for lost resources.

7

Capture™ 2.0 Software
Reference Manual

2
2.4

Start Page
Audio Device and Sample Rate

2.4

Audio Device and Sample Rate

Capture 2.0 was created for use with PreSonus StudioLive-series mixers
and fully functions only with that device. The Audio Device menu displays
the currently selected audio driver. When a StudioLive is connected, you
should select “PreSonus FireStudio” from the Audio Device list.
If the currently selected audio device has exactly two outputs (as with the builtin audio card in a Mac), Capture goes into Stereo mode. While in Stereo mode,
Capture connects all tracks to the stereo output and adjusts the volume of the
output automatically to account for stereo summing. Stereo mode enables you
to listen to Sessions while away from your StudioLive. Unless the StudioLive’s
driver is selected, you cannot create a new Session or record new audio.
The Sample Rate menu displays the currently configured sample rate.

2.5

Options Menu
The Options button can be found just above the bottom of the Start page. This
launches the Options menu.

This menu can also be accessed from Capture>Options.

It can also be accessed by clicking on the Options button on
the Session page.

The Options menu provides all the tools necessary
to configure your Session preferences.
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2.5.1 Audio Options

Audio Device. At the top of the Audio Options, you will find the Audio Device menu.
This is the same menu that is on the Start page. See Section 2.4 for information.
Device Block Size. This displays the buffer size. In general, the higher the
buffer size is set, the more stable your recording environment will be.
Sample Rate. The Sample Rate menu is also found on the
Start page. See Section 2.4 for information.
Record Format. The Record Format menu allows you to choose the bit-depth of the
recorded audio. You can select 16-bit WAV, 24-bit WAV, or 32-bit floating point WAV.
Power User Tip: The higher the bit-depth of your audio, the better its resolution, and
the bigger the resulting file size will be. In general, we recommend recording at 24-bit.
Pre-Record Buffer. Capture 2.0 allows you to set a Pre-Record buffer.
This buffer starts recording audio before your click the Record button so
you won’t miss the beginning of a performance. The Pre-Record buffer
time is user-selectable, between five seconds and one minute.
Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture 2.0
will require. For example, a 32-track recording with a Pre-Record buffer of 1 minute will
require approximately 800 MB more RAM than the same recording set with a buffer of
5 seconds. While this will not cause problems on modern systems that are equipped
with copious amounts of RAM, it is highly recommended that the Pre-Record buffer be
set as low as possible on systems with the minimum amount of required RAM (2 GB).

2.5.2 Timeline Sync Options

Timeline Sync Mode. Capture 2.0 features a Timeline Sync mode. This
allows you to align the timeline in your recording Session to the time of
day or to sync it to an external MIDI Time Code signal. This will also affect
the timestamp information, which is written into the audio files:
•• No sync. The timeline will start at 0 and will display the length of
your recording (in minutes and seconds only). This option is useful
when you only want to track the length of your recording.
•• Sync to computer time. The timeline ruler will start at the exact time of
day the recording began. This option is useful when recording multiple
performances over the course of a day (e.g., at a festival stage).
•• Sync to MTC. Capture will align the timeline to incoming MIDI Time
Code. This option is useful when recording audio for a live video.
MIDI Time Code Input. To use the Sync to MTC option, you must provide Capture
with an input for the source time code. You can select that source from this menu.
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2.5.3 File Handling Options

As discussed in Section 2.1, Capture 2.0 provides an assortment
of useful tools to organize and label Capture Sessions.
Storage Location. By default, all Capture Sessions are stored in the Capture
subfolder in your Documents folder. You can set a new default location
by clicking on the “Change…” link. This will launch a browser window,
allowing you to find a new location for your Capture Sessions.
Name Scheme. Section 2.1 discusses the various options for
naming and organizing your files. This option enables you to
select the order in which your files are categorized.
Create Subfolders. Clicking the Create Subfolders option will create a folder for
each of the three naming conventions: Artist, Performance, and Location. If this box
is not checked, your Session and the resulting audio files will still be labeled using
these tags but a folder hierarchy will not be created. This box is enabled by default.
Add Date to Path. By default, Capture automatically adds the date of the Session
to the Session name. You can remove the date by unchecking this option.

2.6

About Capture 2.0
At the bottom of the Start page, you can view information about
Capture 2.0, including your version-number build date.
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Capture 2.0 features a single-window user interface so you don’t need to
manage multiple windows and views. When a new Session is created, or an
existing Session is opened, you will be taken to the Session page. This page
contains all of the necessary tools to record and edit multitrack audio.
Capture 2.0 takes full advantage of the StudioLive’s bidirectional FireWire bus
and hardwired configuration. When you launch Capture 2.0, a recording track
is created for each input channel on your StudioLive. That track, in turn, is
automatically patched to the corresponding FireWire return on your StudioLive
mixer for playback. The following diagrams show this one-to-one relationship.
Capture 2.0 Recording Routing
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Capture 2.0 Playback Routing

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

There is no need to set up audio inputs and outputs in Capture 2.0, as the software
automatically detects which StudioLive model is connected (a StudioLive 24.4.2,
one or two 16.4.2s, or a 16.0.2) and auto-configures for it. Each input from the
StudioLive mixer is represented with a mono input track in the Track column
of the Session and has a corresponding level meter in the meter bridge.
StudioLive 24.4.2 and 16.4.2 owners: An additional stereo track will also be added
to the Session for recording the first pair of auxiliary inputs (Inputs 25-26/17-18).
It is possible to process each StudioLive mixer input channel with the Fat Channel
before the input signal is routed to Capture 2.0. To do this, engage the Post button in
the Dig Out section of the Fat Channel for each channel in your StudioLive mixer. This
routes the signal post-EQ and post-dynamics processing.

3.2

Track Column
Along the left side of the Session page, you will find the Track column. The Track
column contains a dedicated audio track for each audio input into Capture 2.0 from
the StudioLive mixer, including a stereo track for StudioLive 24.4.2 and 16.4.2, and
provides the following essential functions:
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Track Naming.
To name a track, double-click on the default name to open a textedit box. Enter the name you would like to use and hit Enter.
There are several benefits to giving each track in your Session a name. First,
it allows you to know at a glance what is being recording where. Second, if
you name your tracks before you begin recording, the audio file recorded
on your named track will be given the same name. So, for example, instead
of a bass line being recorded as Track 15, it would be recorded as Bass.
Power User Tip: As with VSL and Studio One, you can press
the Tab key to move to the next track’s name field.
Arm All.
In the upper left-hand corner, you will find the Arm All button. Click this button to
arm all inputs for recording.
Track Controls.
Each track in the Track column features the same controls.
Record Arm Button. Next to each track number is the
Record Arm button. When this button is active, Capture 2.0
is ready to record audio that is routed to the track.
Power User Tip: The track number to the left of each track in the list corresponds
directly to the same channel number on your StudioLive mixer.
Track Mute. Each track features a Mute button. This mutes the track during playback.
Track Solo. Each track features a Solo button. This will solo the track and mute
all other tracks during playback (similar to the SIP function on the StudioLive).

3.3

Transport
The Transport is located in the top left corner of the Session page. It
contains all the functions you need to navigate through your Session.

Stop. Stops playback.

Play. Starts playback at the current playback-cursor position.

Record. Starts recording at the current playback-cursor position.

Session Lock. The Record Lock button prevents the recording from accidentally
being stopped by an errant press of the space bar. Record Lock is automatically
enabled when Capture starts recording. It can be defeated by simply clicking on it or
by key command [Ctrl]/[Cmd]+[L].
Power User Tip: Markers can still be edited and dropped while Session Lock is enabled.
Return to Zero. Returns the playback cursor to the beginning of the Session.
Previous Marker. Jumps the playback cursor to the previous marker.
Rewind. Rewinds as long as this button is enabled.

13
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Fast Forward. Fast-forwards as long as this button is enabled.
Next Marker. Jumps the playback cursor to the next marker.

Go To End. Jumps the playback cursor to the end of the recorded audio.
Loop. Engages/disengages Loop mode. See Section 3.6.6 for more information.

3.4

Time Display

The Time Display provides you with critical information about your recording.
Session Name. Displays the name of the current Session.
Record Duration. Displays how long the current Session has been recording.
Current Position. Displays the current timeline position of the playback cursor.
Remaining Time. Displays the remaining time that can be recorded, based on the
size of the available storage left on the hard drive to which you are recording.

3.5

Timeline Ruler

At the top of the Session Editor, you will find the Timeline
Ruler. This displays time increments in seconds.
As mentioned in Section 2.5.2, you can set the Timeline Ruler to sync
to your computer’s clock or to an external MIDI Time Code source.

3.5.1 Zooming
You can zoom in and out of your Session, with respect to time, in the Session
Edit Window, so that you can look at the entire length of the Session or
just view a small region of time to make accurate edits. You can also zoom
in and out with respect to the size of the audio files in your Session.
To zoom, do one of the following:
•• To zoom in or out, click-and-drag left or right on the Horizontal Zoom scroll bar in
the lower right-hand corner of the Edit window.
•• Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.
•• Click inside the Timeline Ruler at any point in time
and drag down or up to zoom in or out.
•• In the lower left-hand corner of the Edit window, you will find the vertical-zoom
controls. These controls increase or decrease the height of the tracks and
audio files.
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3.5.2 Scrolling

To scroll left and right through time in your Session, click-and-drag
the horizontal scroll bar near the bottom of the Edit window.
You can also scroll through your Session by clicking and
dragging the Timeline Ruler left or right.

3.5.3 Locate Selection

To jump the playback cursor to the beginning of any audio event,
press L on the keyboard or select Session>Locate Selection.

3.6

Editing Tools

In the upper right corner, you will see four editing-tool buttons. These
tools will determine the function of your mouse during editing.
Power User Tip: The audio-editing process can be unforgiving: Small inaccuracies when
splitting, moving, or performing other actions on recorded audio can lead to unwanted
results. As simple as it may seem, the act of listening while editing is often overlooked.
For instance, when sizing the edges of a vocal part to remove unwanted sounds
between words, it is tempting to make the edits based on the visual representation of
the waveform. While this may work sometimes, it is much better to listen as you size
the events to be sure you are not removing any critical part of the vocals. Listening
to your edits as you make them will save time and frustration in nearly every case.
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3.6.1 Arrow Tool
This is the default tool for access to most functions. Click on the Arrow tool button or
press [number 1] on the keyboard to select the Arrow tool.
The Arrow tool can be used for the following purposes:
Move an Event.
To move an audio event using the Arrow tool, click anywhere on the event and
drag left, right, up, or down. Dragging the event left or right will move the event
backward or forward in time. When dragging an event left or right beyond the
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.

Dragging the event up or down will move the event to another track.
When dragging an event from one track to another (up or down), the
position of the event will be constrained within an automatic snapping
range to make it easy to keep the event at the same time position. To
defeat this snapping, hold Shift while dragging the event up or down.

Rearrange Tracks.
To rearrange tracks using the Arrow tool, click on the track you want to move and
drag up or down in the Tracks list. You will notice a blue line following your mouse.
When you drop the track, it will be inserted where the blue line is located.
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Size an Event.
Events can be thought of as windows into audio files and musical performances,
where what you see is what you hear. You can resize events to make them shorter
or longer so that only a portion of the audio or musical data is seen and heard.

To size any event using the Arrow tool, float the mouse to the left or right edge of the
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to
size the event. Events can be sized and resized nondestructively any number of times.
Select Multiple Events.
Multiple events can be selected in order to edit them all at once, with a single
action. To select multiple events with the Arrow tool, do one of the following:

•• Click outside of the range of an event and then drag over any other
events; a gray box will be drawn while you drag over the target-selection
area. Release the mouse button once the box is drawn over all of the
events you wish to edit, and these events will be selected for editing.
•• Click on any event; then, while holding [Shift] on the keyboard, click on any other
events to select them. This allows you to select multiple events that are not in
close proximity to each other. All selected events can then be edited at once.
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3.6.2 Range Tool
The Range tool is used to select a range, or area, within events. Click on the Range
tool button or press [number 2] on the keyboard to select the Range tool.

To select a range within an event, using the Range tool, click-and-drag over the
area to be selected; a gray box will be drawn over the target selection area. Release
the mouse button when the box is drawn over the range of the events you wish to
select. The range you have selected is now treated as a single, consolidated event.
The Range tool can be useful in several ways:
•• You can use the Range tool to select the content of several audio events
across multiple tracks for a specific portion of a song (say, an amazing
drum groove) and then use the Arrow tool to move that section of
audio to another section of a song (say, to replace a drum groove).
•• Another common use of the Range tool is to quickly select and delete a
range of audio within an event, rather than using the Split tool to make
two splits, then select and delete the section with the Arrow tool.
Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool
will temporarily appear. This makes it easy to quickly select and edit a range of events.
To select multiple, discontiguous ranges across any event, on any track, hold the
[Shift] key while using the Range tool. Continue to hold [Shift] and use the Arrow
tool to select whole events. For instance, when using the Arrow tool, if you press
and hold [Ctrl], you get the Range tool. Press and hold [Ctrl] and [Shift] to select
multiple ranges, then continue to hold [Shift] but release [Ctrl]; now you have the
Arrow tool and can select whole events. All of your selections will remain selected.
Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left
and right edges of the selection by choosing Split Range from the Edit
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

3.6.3 Split Tool
Using the Split tool, single events can be split into multiple events. Click on the Split
Tool button or press [number 3] on the keyboard to select the Split tool.
With the Split tool selected, a vertical and horizontal line will be drawn near the
current mouse-cursor position. The vertical line indicates the exact time position
of the Split tool, while the horizontal line underscores the track on which the event
to be split resides. The Split tool is directly affected by the current Snap settings.
Click on any event with the Split tool to split the event at that position.
By splitting a single event, you create two events that can be edited
independently. If multiple events are selected across multiple tracks,
the Split tool will affect all of the selected events in the same way.
It is also possible to split selected events at the timeline cursor, without
using the Split tool, by pressing [Alt]+[X] on the keyboard.
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3.6.4 Eraser Tool
The Eraser tool is used to delete an event. Click on the Eraser Tool button or press
[number 4] on the keyboard to select the Eraser tool. To delete any event using the
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current
selection and will only affect the event that is directly clicked on.
However, if you click on a selected element with the Eraser
tool, all currently selected elements will be erased.

3.6.5 Common Editing Actions
Like most software applications, Capture 2.0 supports basic cut,
copy, and paste actions. Once you’ve selected an event, or a range
of events, you can perform these actions as follows:
•• Cut: Press [Ctrl]/[Cmd]+X on the keyboard to cut
the current selection or select Edit>Cut.
•• Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy
the current selection or select Edit>Copy.
•• Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard
to paste the selection or select Edit>Paste. The selection will be pasted to the
current playback-cursor position, or to the beginning of the track from which
the selection originated if the playback cursor is not currently set anywhere.

3.6.6 Looping
To loop the playback of any range of your Capture
2.0 Session, do one of the following:
•• Loop Selection. Select an event with the Arrow tool or select a range with
the Range tool. Go to Session>Loop Selection or press P on your keyboard.
This will create a loop the exact length of the selected audio event. The range
will be indicated by a bar drawn in the timeline, with flags at both ends.

•• Custom Loop Range. To create a custom loop range, mouse over
the gray line above the timeline ruler. Notice that your cursor
changes to a Pencil tool, and you can draw your loop range.
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Once your loop range is set, you can click on the Loop button in the transport, or
press [L] or [/] on the keyboard, to engage Loop mode.
Please Note: Engaging Record in the transport will disable Loop
mode and will begin recording at the current playback-cursor
position. It is not possible to engage Loop while recording.

3.6.7 Bounce Selection

Once you have edited an audio file, you may wish to create a new audio
file that includes all of your edits. To do this, use the Range tool to select
the events you would like to merge as described in Section 3.6.2 and press
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.

3.7

Meter Bridge

Capture 2.0 provides input and output metering when a track is being recorded
or played back. These peak-style meters at the bottom of the Session page
feature clip indicators for each input into Capture 2.0 from the StudioLive
mixer. StudioLive 24.4.2 and 16.4.2 users will see an additional pair of meters
for the routable Master track. (See Section 3.7.1 in the StudioLive Software
Library Reference Manual for details on how to route a bus to this track.)

3.7.1 Record Arm
Below each meter, you will find another Record Arm button. This button provides the
same functionality as the Record Arm button in the Track column. See Section 3.2 for
more information.

3.7.2 Link Button
Between each meter you will find a Link button. When this button is active, Capture
2.0 will record that track as a stereo-interleaved file. By default, the routable bus pair
(25-26/17-18) is link-enabled, as are the stereo channels on the StudioLive 16.0.2
(9-10/11-12/13-14/15-16).
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3.7.3 Big Meter Mode

The Big Meter Mode button is located in the upper right
corner of the Session page, above the editing tools.
When this button is engaged, the lower three-quarters of the Session page will
display detailed metering for every track. While in this mode, the Marker Lane,
transport, mode buttons, and editing tools will still be visible.

3.8

Markers and the Marker List

3.8.1 The Marker Lane

The Marker Lane is located just below the Timeline Ruler.
It displays any markers you have created.
In Capture 2.0, the Marker Lane is used to place markers at desired
places in the timeline, after which navigation to the markers is easy.
Markers are also helpful when exporting your Session to individual
mixes or for editing in another recording application.
Power User Tip: We highly recommend that markers be inserted
during the recording of a live performance, as the markers will
make the rest of the production process much easier.

3.8.2 The Marker List

The Marker List button is located above the editing tools on the right side
of the Session page. Clicking on the button will open the Marker List, which
provides an overview of every marker in your Session and offers an easier
way to quickly name markers and move them around your Session.
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3.8.3 Inserting, Naming, Deleting, and Moving Markers
Marker Lane.
Adding/Deleting Markers. At the top of the Track Column, you will see the Add/
Remove Marker buttons. To insert a new marker into the Marker Lane, with playback
running or stopped, click on the Add Marker (+) button, or press [Insert] on the
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3….).
Select a marker and click on the Remove Marker (-) button to remove the marker.
Naming Markers. To rename a marker, double-click on the marker in the Marker
Lane, type in a new name, and then press [Enter] on the keyboard.

Moving Markers. To move a marker, click on it in the
Marker Lane and drag it to the desired location.

Marker List.
At the bottom of the Marker List, you will find three buttons.

Adding Markers. Click on Add Marker to add a marker
at the current playback-cursor position.

When a Marker is added to the Marker List, the Name field
automatically becomes editable. Enter a new name and hit Enter.
This name can be edited later by double-clicking on it.
Moving Markers. Clicking on the Move Marker button will move the currently
selected marker in the Marker List to the current playback position in the timeline.
Deleting Markers. To remove a marker, select it in the
Marker List and click on the Delete Marker button.
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3.8.4 Navigating Markers
It is possible to quickly jump the playback cursor between markers in
the Marker Lane. Jumping to markers during playback allows quick
comparisons between different sections of your Session.
To navigate to a previous marker, do one of the following:
•• Click on the Previous Marker button in the transport.
•• Press [B] on the keyboard, to jump to the previous marker.
To navigate to the next marker, do one of the following:
•• Click on the Next Marker button in the transport.
•• Press [N] on the keyboard, to jump to the next marker.
To jump to any marker in your Session, open the Marker List and click on the
Location field. The playback cursor will jump to this location in the timeline.
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Setting Input Levels: Setting the proper input level is critical to making a good
live mix and a good recording. The basic idea is to set the input gain on the
StudioLive mixer as high as possible without overloading the input. Overloading
the input will cause clipping (digital distortion), which is particularly unpleasant
and will ruin the recording. This damage cannot be undone in software. There
is a clip indicator for each input on the StudioLive mixer for this purpose.
If an input channel is not clipping on your StudioLive mixer, you can be
sure that it will not clip in Capture 2.0. Refer to Section 2 in your StudioLive
Hardware Owner’s Manual for the proper level setting procedure.
You will monitor live audio input on the StudioLive mixer; there is no separate
monitoring capability within Capture 2.0. Please refer to Section 4.4 in the
StudioLive Hardware Owner’s Manual for information on creating monitor mixes.
Recording a Stereo Mix (StudioLive 24.4.2 and 16.4.2 only). The Auxiliary
Stereo Track in Capture 2.0 is a stereo track intended to be used to record a stereo
mix from your StudioLive. This mix can be recorded while recording the individual
input channels so that a mix is available immediately after a live show, or you
can use this track to route your final studio mixes through the StudioLive.
As discussed in Section 3.7.1 of the StudioLive Software Library Reference
Manual, VSL features an Auxiliary Inputs Router that allows you select which
buses you want to record in addition to your input channels. The last two tracks
in Capture are dedicated for recording a stereo mix in Capture 2.0. In addition
to the Main L/R mix, you can select from any pair of the following outputs,
buses, and inputs: Subgroups 1-4, Auxes 1-10/6, FXA and B Send Mixes, FX A
and B Stereo Returns, Aux Inputs A and B, Tape In, Solo Bus, and Talkback.
Arming Tracks. To record to an audio track, the track must be record-enabled, or
“armed.” Capture 2.0 provides two Record Enable buttons for each input: one on the
track and on the meter bridge. Once an audio track is record enabled, you are ready
to record audio to that track.
Hit Record! To activate recording, click on the Record button in the transport. The
Record button will turn red, and the Play button will turn green. The playback cursor
will start to scroll from left to right from its current position, and new audio events
will be recorded to record-enabled tracks.
Recording will continue until you manually stop it by clicking on the Stop button in
the Transport or by pressing [Spacebar] on the keyboard.
When you press Record, the Session automatically locks. This prevents you from
accidentally stopping recording Session. You must disable Session Lock before you
can stop recording.
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We’ve all been there. The drummer is stuck in traffic. The guitarist is stuck at work.
And you’re stuck at front-of-house (FOH) with a hyped up lead singer and bass
player and no way to dial in a FOH mix, let alone set up the singer’s in-ear mix.
Don’t panic! With Capture 2.0’s Virtual Soundcheck mode, dialing a good rough
mix without the band—or with half the band missing—is quick and simple.
1. To begin, create a new Session, preferably metatagged with the Artist,
Performance, and Location information.

2. From your empty Session, click on the Soundcheck Mode button
in the upper right hand corner of the Session page.

3. Capture will automatically search your computer for Sessions and will open a
list from which you can choose a Session to use for Virtual Soundcheck.

4. Select the Session you would like to use and click “OK.”
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5. The saved Capture Session will open.

6. Engage the FireWire Return buttons on your StudioLive for
the channels for which you don’t have live inputs.
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Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

Input

7. Press Play in Capture and dial in your mix.
8. When you have finished setting up your mix, click the
Virtual Soundcheck Mode button again to exit.
9. The track labels from the Soundcheck Session are automatically loaded into your
blank recording Session.
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It is possible to import WAV and AIFF audio files into your Session.
1. To import an audio file, select Import File from the Session menu, or
[Ctrl]/[Cmd]+I on the keyboard, to open the Import File menu.

2. Browse to the desired file and click on it to select it.

3. Click on Open to import the file into your Session.
4. An audio event for the imported file will be created and placed on the currently
selected track in your Session, at the current playback-cursor position.
Power User Tip: When browsing for files in the Import File menu, it is possible to listen
to the audio files as you are browsing in the Preview Player. Click the Play button in the
Preview Player to play the currently selected audio file. Click the Stop button to stop
playback. Click the Loop button to loop the playback of the currently selected audio file.
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To export audio from your Session in Capture 2.0, navigate to Session/Export
Tracks, or press [Ctrl]/[Cmd]+E on the keyboard to open the Export Tracks menu.

Location.

In the top section of the Export Tracks menu, select
a location and name for the audio file.
Click on the Browse button to choose a file location.
Double-click on the filename, type in a new name, and then press Enter
to choose a name for the file. Each file that is exported will begin with the
filename you enter, followed by the name of the track from which it was
exported and the first marker of the marker pair (if applicable). Examples:
“1602 Demo Session – kick” or “1602 Demo Session – Kick – Chorus.”
Format.

In the middle section of the Export Tracks menu, select the
format of the mixdown audio file. Choose from WAV or AIFF, and
then choose the desired resolution and sample rate.
If you wish to put your audio on a standard audio CD, the format should
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.
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Options.

The bottom section of the Export to Audio File menu has
several options that will affect how files are created:
•• Export Session will export the entire range of your Session to the
furthest point in time that any audio event on a track extends.
•• Export Between Each Marker will export separate files for
each range between the markers in the Marker Lane.
•• Export Between Selected Markers will export audio files between
the ranges of any two selected markers in the Marker Lane.
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7.1

Creating a Mix in Capture 2.0
You can’t mix directly in Capture 2.0; instead, you mix with the StudioLive.
The individual outputs of each audio track in Capture 2.0 are hardwired to
the FireWire Returns for each corresponding input channel on the StudioLive
mixer. With the FireWire Returns engaged for each input channel on your
StudioLive mixer, the output of your multitrack Capture 2.0 Session is routed to
the StudioLive mixer, where it can be mixed just like any other audio input.
The process of creating a mix with Capture 2.0 and the StudioLive
mixer is quite simple. Play back your recorded tracks through the
StudioLive and record the main output of the StudioLive to the Auxiliary
Stereo Track in Capture 2.0. The process works as follows:

1. StudioLive 24.4.2 owners: In VSL, select “Main
Mix L/R” for Auxiliary Inputs 25 and 26.

StudioLive 16.4.2 owners: In VSL, select “Main
Mix L/R” for Auxiliary Input 17 and 18.

StudioLive 16.0.2 owners: In VSL, patch “Main Mix L/R” to Flexible
Inputs 15 and 16. Please note: If you wish to create a mix using Capture
2.0, you will not be able to record using analog inputs 15 and 16.

2. Be sure that Record Arm is disabled for all audio-input tracks
in Capture 2.0 and that the FireWire returns for all input
channels on the StudioLive mixer are engaged.
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3. In Capture 2.0, select the Auxiliary Stereo Track (StudioLive 24.4.2, and 16.4.2) or
Track 15/16 (StudioLive 16.0.2) and enable Record Arm.
4. Bring the playback-cursor position to the beginning of the Session by clicking the
Return to Zero button in the transport.
5. Activate recording by clicking on the Record button in the transport; the playback
cursor will begin to move from left to right, and audio will play through each input
on the StudioLive mixer. The Auxiliary Stereo Track in Capture 2.0 will record a new
audio event, which is the main mix from the StudioLive mixer.
The new audio event that has been recorded from the StudioLive mixer will be
stored as a stereo WAV file at the sample rate to which the StudioLive mixer is set.

7.2

Exporting Your Final Mix to an Audio File
The most common physical medium on which recordings are published
is the audio CD. In order to put your final mix on an audio CD, the mix file
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final mix
to the Auxiliary Stereo track in Capture 2.0, it is recommended you export
the audio from the Auxiliary Stereo track to an audio file for this purpose.
See Section 6.2 for details on Exporting Audio Tracks in Capture 2.0.
Once the correct audio file for your mix has been exported, you
may use any CD-burning application (including PreSonus Studio
One Professional) to put that mix on a recordable audio CD.

7.3

Mixing a Capture 2.0 Session in Studio One
Many users want to use Capture 2.0 strictly as a track-recording tool and mix
and sweeten the recorded tracks later in a DAW application. PreSonus has
included a copy of Studio One Artist with your StudioLive for this purpose.
All versions of Studio One can open Capture 2.0 Session files. All markers,
edits, track names, etc., will be preserved, and no further effort is required.
Simply launch Studio One and open your Capture 2.0 Session. (See Section 7
in the StudioLive Software Library Reference Manual for more details.)

7.4

Mixing a Capture 2.0 Session in a Different Recording Application
For users who wish to mix their Capture 2.0 Session in a DAW other than Studio
One, there are several ways in which to import your Capture 2.0 Session.

7.4.1 Save a Capture 2.0 Session as OpenTL
Many audio-recording programs can open OpenTL (Open Track List) files.
An OpenTL file provides a reference for all of the audio tracks and audio
events, with their corresponding positions, in a Capture 2.0 Session, so
that another audio program can reconstruct your Session automatically.
This makes it possible for you to open your Capture 2.0 Session and
work as you normally do in your favorite recording application.
To save an OpenTL version of your Session, select Save
Session As in the File menu of Capture 2.0.
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Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box.

Click on Save to save your Session as an OpenTL document and confirm the
command by clicking Yes in the confirmation window. This file will be placed
by default in your Session folder and will not overwrite the original Capture
2.0 Session file. Note that the OpenTL format will not save your markers.

7.4.2 Import Capture 2.0 Session Audio Files Directly
Some audio-editing applications (such as digital audio workstations, or DAWs)
do not support the OpenTL format, which makes the options somewhat limited
when importing Sessions created in other programs. In this case, you must
manually import the audio events from your Capture 2.0 Session into the audioediting application, using whatever means possible in that program. Refer to
the documentation of your software for more information on this process.
Note that in some cases, you may have more than one audio event on a given track,
as opposed to a single continuous audio event, or you may have audio events that
do not have the same start position. In either case, it is highly recommended that
you first export the audio for each track before attempting to import into an audioediting program, as described in the Export Audio Files portion of this section.
Be sure to select the Session option in the Export Tracks menu so that the result
of the process will be a single continuous audio file for each track in the session.
Once you have single, continuous audio files for each track, directly importing
the files into an audio editor is much easier. All that is required to reconstruct
your Capture 2.0 Session is to align each file at the same start time. For complete
information on exporting tracks from Capture 2.0, please review Section 6.2.

32

8
8.1

Capture 2.0 Key Commands
Quick Reference Guide

8

Capture 2.0 Key Commands

8.1

Quick Reference Guide

Action

Key Command

File Menu

Capture™ 2.0 Software
Reference Manual

Action

Key Command

Transport

New Session

Cntrl/Cmd+N

Toggle Start/Stop

Space Bar

Open Session

Cntrl/Cmd+O

Start

Enter

Close Session

Cntrl/Cmd+W

Record

NumPad *

Save Session

Cntrl/Cmd+S

Stop

NumPad 0

Save Session As

Cntrl/Cmd+Shift+S

Return to Zero

NumPad

Quit

Cntrl/Cmd+Q

Record Lock

Cntrl/Cmd+L

Edit Menu

Navigation

Undo

Cntrl/Cmd+Z

Focus Next

Tab

Redo

Cntrl/Cmd+Y

Focus Previous

Shift+Tab

Cut

Cntrl/Cmd+X

Left

Left Arrow

Copy

Cntrl/Cmd+C

Extend Selection Left

Shift+Left Arrow

Paste

Cntrl/Cmd+V

Extend Selection Left Add

Cntrl/Cmd+Shift+Left Arrow

Delete

Del

Skip Left

Cntrl/Cmd+Left Arrow

Select All

Cntrl/Cmd+A

Right

Right Arrow

Deselect All

Cntrl/Cmd+D

Extend Selection Right

Shift+Right Arrow

Bounce Selection

Cntrl/Cmd+B

Extend Selection Right Add

Cntrl/Cmd+Shift+Right Arrow

Zoom In

Cntrl/Cmd + or E

Skip Right

Cntrl/Cmd+Right Arrow

Zoom Out

Cntrl/Cmd - or W

Up

Up Arrow

Zoom Full

F

Extend Selection Up

Shift+Up Arrow

Session Menu

Extend Selection Up Add

Cntrl/Cmd+Shift+Up Arrow

Import File

Command+I

Skip Up

Cntrl/Cmd+Up Arrow

Export Tracks

Command+E

Down

Down Arrow

Toggle Start/Stop

Space Bar

Extend Selection Down

Shift+Down Arrow

Record

NumPad *

Extend Selection Down Add

Cntrl/Cmd+Shift+Down Arrow

Stop

0

Skip Down

Cntrl/Cmd+Down Arrow

Return to Zero

,

Page Up

Page Up

Go to End

E

Extend Selection Page Up

Shift+Page Up

Loop Active

/

Extend Selection Page Up Add

Cntrl/Cmd+Shift+Page Up

Loop Selection

P

Skip Page Up

Cntrl/Cmd+Page Up

Locate Selection

L

Page Down

Page Down

Insert Marker

Ins, I

Extend Selection Page Down

Shift+Page Down

Insert Named Marker

Shift+Ins, Shift+I

Extend Selection Page Down Add

Cntrl/Cmd+Shift+Page Down

Locate Next Marker

N

Skip Page Down

Cntrl/Cmd+Page Down

Locate Previous Marker

B

Start

Home

Enable Sound Check

F4

Extend Selection Start

Shift+Home

Extend Selection Start Add

Cntrl/Cmd+Shift+Home

Tools
Select Arrow Tool

1

Skip Start

Cntrl/Cmd+Home

Select Range Tool

2

End

End

Select Split Tool

3

Extend Selection End

Shift+End

Select Eraser Tool

4

Extend Selection End Add

Cntrl/Cmd+Shift+End

Skip End

Cntrl/Cmd+End

Views
Options

Cntrl/Cmd+[+]

Big Meters

F2

Marker List

F3

Enable Soundcheck

F4
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Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for…
Redfish Couvillion
Ingredients:
••
••
••
••
••
••
••
••
••
••
••

¼ C Vegetable oil
¼ C flour
1 onion diced
1 clove garlic minced
1 green pepper diced
3 celery stalks diced
1 14oz can diced tomatoes
1 bottle light beer
2 bay leaves
1 tsp thyme
2 lbs Redfish fillets

Cooking Instructions:
1.
2.
3.
4.
5.
6.
7.

In a heavy saucepan or large skillet, heat oil on medium high and slowly add flour a tablespoon at a time to create a roux.
Continue cooking the roux until it begins to brown, creating a dark blond roux.
Add garlic, onions, green pepper, and celery to roux.
Sauté vegetables for 3-5 minutes until they start to soften.
Add tomatoes, bay leaves, thyme, and redfish. Cook for several minutes.
Slowly add beer and bring to a low boil.
Reduce heat and simmer uncovered for 30-45 minutes until redfish and vegetables are completely cooked, stirring
occasionally. Break up redfish into bite size chunks and stir in. Add pepper or hot sauce to taste. Do not cover.
Serve over rice

Serves 6-8

While not one of Southeast Louisiana’s more famous dishes, Redfish Couvillion is a favorite way to serve our
favorite Gulf fish. Also known as Reds or Red Drum, Redfish is not only fun to catch, it’s also delicious!
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